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How EasyPlan 
came about…

In or around 1997, Stephen Hunter, an electrical engineer, 
embarked on his journey to become a pilot, training at 
Grand Central Airport. However, he soon found that 
manually planning flight routes was cumbersome, so he 
began programming basic flight planning algorithms on a 
computer, tailored specifically for South African aviation 
requirements.

This innovative solution garnered significant interest among 
pilots and proved to be highly successful.

Subsequently, Stephen Hunter joined forces with Andrea 
Antel, author of the "Airfields for Southern Africa" book, 
which had been published since 1997. Together, they 
embarked on a joint venture to enhance and expand the 
software. Through their collaboration, the software evolved 
into EasyPlan, which quickly became a favourite among 
pilots and charter operators alike.

With continuous improvements and the addition of new 
features, EasyPlan solidified its position as one of the most 
popular flight planning software in Southern Africa. The 
input and support from professional pilots, along with 
assistance from SACAA inspectors in navigating legal 
requirements, further enriched the software's development.



• Flight Planning on a bigger screen

• Able to print out flight logs for your kneeboard

• Print out ATC flight plans, airfield info, weight & balance

• Can print maps and vertical navigation

• Export flight plans into format for Garmin, MGL etc.

• File2fly directly with ATNS

• Free Electronic Logbook

• Export your flight plans to EasyCockpit

• View your flown flights on the bigger screen

• Best, Most comprehensive and Up-to-date Aeronautical 
Information

• Local Support

• In-flight Navigation App for your Phone and/or tablet

• Take your “Best, Most comprehensive and Up-to-date 

Information” into the Cockpit and have everything at 

your fingertips

• Has all the normal GPS functionalities

• Can be used autonomously

• View your recorded flights in EasyPlan or Google Earth

• Fly your planned routes in Simulation.

• Download actual Weather data during flight, when 

connection is available.

• Warnings popping up: Terrain, Obstacle Airspace

What’s … and what’s



• Toolbar and 
• Display options
• Settings and setting up your User Preferences
• Before starting a flight plan, set up your Aircraft Data as this will 

define your performance figures like Climb-, Cruising -, Descent 
speeds as well as Fuel Calculations

• Create a flight plan and check all legs
• Check weather
• File flight plan if required, make sure you have ticked all 

required points ‘in FP’ and ‘in EET’
• Print out flight log
• Export your flight plan to GPS devices

Getting Started - Familiarize yourself with the software



Open/Save/Print Function
When pressing this printer 
icon, only the page shown 
on the screen will print, 
whereas under
File – Print, the entire 
document can be printed.

Task buttons:
• Insert/Remove Descent  and Top of 

Climb points 
• Enable/Disable Alternate Airfield
• Auto scale
• Zoom In/Out
• Show/Display South Africa (will zoom 

out completely)
• Slider to show Map 3D contrast
• Displays Weather after you 

downloaded the weather data 
(requires a valid weather subscription

Map Display
Click these Layer icons to 
select what points, 
airspaces and features you 
want to see on screen.

Getting Started 
The Toolbar:

Tip: When moving the mouse over the icons, a description panel will come up.

Map Display
• Labels,
• Ground features On or 

Off and the
• Display of Areas and 

Borders add to the ease 
of use



S T E P  1  -  s e t  y o u r  U S E R  P R E F E R E N C E S

Enter your preferred Units and Preferences, which will be automatically saved on exit.

Units & Preferences:  General Configuration

Display Seconds: Display flight times in 

hours : minutes : seconds.

Default is set to hours: minutes.

Latitude/Longitude: Select display mode.

You have various options.

Select preferred units of measurement.

You are also able to change Units within the 

various screen options by clicking on them. 

(e.g. in the FlightLog window)



Units & Preferences:  Flight Log

Offset Columns : Enroute information, 

applicable on the leg between two points, is 

displayed offset between the two points.

Display Short Headings : Display abbreviated 

headings in flight log

Print Clearances form : Prints form to write 

down ATC clearances, and enroute navigation 

info.

Print Notes : Prints notes associated with this 

route.

Print Airfield Info : Additional information on 

airfields, contained in the EasyPlan database, 

that are part of the route can be printed with 

the flight log. Select the size required. Select 

“Small” and  then print in Landscape mode -

works well for creating a printout that can be 

used on an A5 kneeboard. 

Switch off "Print Clearances", "Print Notes", 

"Print Airfield Info" and select landscape 

mode to print the Flight Log (Original) across 

the entire width of an A4 page.



Units & Preferences:  Flight Log

Flight Log Print Formats

Original - Prints the flight log as displayed 

on the screen, using the same columns 

selected.

Fixed Format : Recommended print setting. 

Prints the flight log in a fixed format 

irrespective of the columns selected. This 

mode automatically detects if wind has been 

entered and modifies the printout 

accordingly. 

The Order of the displayed and (to be) 

printed columns of the Flight log can be 

re-arranged:

• Left Click and hold down on the Column 

Name; 

• Move/drag to desired position while 

holding down the mouse key. 

• Then release. 

This option only works when no flight 

plan/log is open. 



Map Display

Current Coverage:
• South Africa
• Angola
• Botswana
• Eswatini
• Lesotho
• Namibia
• Mozambique
• St Helena
• Zambia
• Zimbabwe



Units & Preferences - Map Display

Display of Map Ground Features

• Select the items to be displayed 

on the map. 

• The elevation can be displayed 

using darker colours for the higher 

ground, or using a 3D effect. (Map 

Colours)

• Hi Definition Elevation. High 

definition elevation data will be 

displayed when zooming in, if the 

files are available. This option uses 

data supplied by NASA with a 

resolution of about 90 meters. 



Units & Preferences - Map Display

Filter Levels

• Filter Level: Select “Main” or “National” to 

display only main or national roads 

irrespective of the zoom.

• Auto Filter Detail: if enabled, less terrain 

detail is displayed as one zooms out, and 

more detail as one zooms in. Select “Less 
Detail” if the map is too cluttered.

• Ground Feature Hint: If this feature is 

enabled, then as the mouse is moved over 

an item the name will be displayed, and if 

the Highlight option is selected, the colour 

will turn green. Note this option only 
works with the updated Terrain Data Base.



Units & Preferences - Map Display

Printing Map

• Print Vertical Nav: - Prints the vertical navigation information 

along with the map.

• Print In Black :- Some of the lighter colours are not printed 

when printing in black. Select this option so that all items on the 

map are printed in black.

• Print Terrain Elevation :

•  - Recommended OFF. When ON, it will print the shaded 

background of the elevation in light or normal colour. This can 

take some time and ink, depending on the printer. 

• If this function does not work with your printer, then use “File” 

“Print” “Print Map to File” to create a bitmap that contains an 

image of the map. “PrintFile.bmp” which is saved in the 

“MyDocuments – EasyPlan3” Folder. 

• This then can be printed from a program like Word.

• Or you can ‘Copy Image to Clipboard’, then paste into a blank 
Word Document.



Units & Preferences - Map Display

Aeronautical Borders 

• Select the border 

thickness for items 

such as TMA’s, FAD’s 

etc. 

• “Auto” selects thick 

borders when the 

ground features are 

displayed, and thin 

borders when the 

ground features are 
switched off.

• Aeronautical Symbols 

Selects the size of the 

symbols, i.e. Airfields, 

VORs. 

• Auto scales the size 

according to display 

zoom.
• Track Width (miles)

Filters

• Reporting Point Filter

• Airways Filter

 Please note, currently only 

Lower ATS routes are 

available. 

• Airfield Filter 

• Display Labels - Select 

which items to label on the 

map. Note that the display 

“Display Labels” button on 

the Toolbar must be 

selected.

• Airspaces in Vertical 

Navigation



Units & Preferences – Map Colours

Selecting Map Colours

The colours of all the features on the map can be changed by clicking on the coloured blocks and use 
the colour sliders to select your favourite colour or the one that works best for you. 

This is useful for the elevation colours when each colour is an incremental change from the previous.

Press ok to confirm the change.

Set back to Default if that works better for you.

BLACK SCREEN
If you experience a sudden BLACK SCREEN when opening EasyPlan, 
Then, in Map Colours, set everything BACK TO DEFAULT.



Flight Plan

Automatically Update Flight Plan: 

• All route changes are automatically updated in the Flight Plan. 

• If you have made some special changes to the Flight Plan, and 

don’t want them over-written, clear this option. 

• Use cruising Speed: Use the aircraft cruising speed in the Flight 

Plan. This is the preferred way.

• Select the country to display the country name on the Flight 

Plan heading

FlightPlan Update and Check 

In your flight plan window you also UPDATE 

AND CHECK the Flightplan. 

EasyPlan will warn you of missing points.



EasyLogbook – see separate presentation 

• The logbook format is according to SACAA 

Part 61 logbook layout. 

• You can use different logbooks if you need 

to keep separate logbooks for fixed wing, 

rotary, simulator. 

• The Part 62 Recreational Logbook in its 

simpler format is approved for recreational 

flying, gliding or microlighting. 

• However, remember if you intend to 

upgrade to a Commercial licence or 

Instrument Flying, you will require the Part 
61 logbook entries.



Tools

A simple calculator, which will automatically work out Standard 

Rate Turn, Density Altitude, Sunrise & Sunset values, and Distance 
to the Horizon.

Operation

• The numbers displayed in blue can be changed. 

 

•  Right Click to decrease and Left Click to increase a value.

• Pressing Ctrl while clicking changes the value by 10 or 100 for 

the Pressure Altitude.

• Left Click on the ‘Units’ to change to your Preference.

• No range checking is done on the input values.

• TAS in Standard Rate Turns is used to calculate the IAS in the 

Density Altitude.



Aircraft Data and Weight & Balance

The Values in this example may not be accurate

• The Weight & Balance does not 

verify if the limit is exceeded but 

provides an easy way for you to 

see what is the resulting Weight 

& Balance. 

• You require your Aircraft Manual 

for the correct information.  

However, you can select an 

aircraft similar to yours from our 

list but still need to check the 
figures from your own manual.

• The graph connects all the points 

described in the Aircraft limits 

and superimposes the aircraft 

Weight & Balance with fuel as 
specified, and with no fuel.



• Left Click on a value to change it.
• Right Click in the 1st column to add or delete a row.
• Left Click on the ‘Units’ to change to your 

preference. 

• Note : The arm or the moment can be entered; the 
other will be calculated automatically.

•  The space for fuel calculations can be re-sized by 
clicking and dragging the top of the panel. 

• En-route fuel stops are ignored for fuel calculations.

• Note: Either arm or moment can be entered; the 
other will be calculated automatically. 

Aircraft Weight & Balance – Calculations

How to get started on your Weight & Balance Envelope

You need:

• Aircraft Operators Flight Manual applicable to your 

aircraft

• Weight (Mass) & Balance Certificate

From the first document you extract the envelope which 

could be in a diagram format or even in a text format.

Enter in this order:

1. empty weight and most forward CoG limit (insert 

either arm or moment value)

2. max certified weight and most forward CoG limit 

(insert either arm or moment value)

3. max certified weight and most aft CoG limit (insert 

either arm or moment value)

4. empty weight and most aft CoG limit (insert either 

arm or moment value)

Maximum certified weight is published in the Operator’s 
Manual
Empty weight is found on the Weight (Mass) & Balance 
Certificate
You can customize the envelope to be Weight versus Arm 
or Weight versus Moment



You can customize the 
envelope to be 
• Weight versus Arm or 
• Weight versus Moment

Aircraft Weight & Balance – Aircraft Limits

Warning if you use any of the 
Sample Aircraft available 
under Route/Aircraft – 
Import Aircraft Data. 
You have to verify and update 
with your own Aircraft 
Operating Manual.



Aircraft Weight & Balance – Performance

• Enter your Aircraft TYPE and Registration Details

• Enter the remaining information from your aircraft operator 

manual, including your contingency fuel and reserve time.

• Left Click on the light blue numbers to enter new data. 

• Left Click on the ‘Units’ to change to your preference. The default values of 

Speed, Height and Fuel Consumption are used as initial values for the Flight Log. 

• The compass deviation is subtracted from the magnetic heading to get the 

compass heading. 

• The Fuel calculations are calculated from the Performance data, the flight details 

in the Flight Log and the Fuel quantity in the Weight & Balance. 

• Or import existing aircraft data from the Route/Aircraft menu. 

• Note:  After updating the Weight & Balance and the performance details of your 

aircraft, click on File | SaveAs and enter a name that describes your aircraft. 

• Tip: all numbers in BLUE can be changed.

When all done: SAVE AS with your aircraft registration. 

It should always default back to this unless you open a 

different aircraft type from 

Route / Aircraft - Import Aircraft Data 



Aircraft Weight & Balance – Calculations

• Units of measurement can be changed under the 

headings, as per your manual

• Enter the Aircraft Empty Weight, found on the Weight & 

Balance Certificate

• An item with a name starting with “FUEL” is interpreted 

as Fuel and displayed in a different colour. This Fuel 

Station (in RED) should not be altered. 

• Enter the amount of fuel you are loading. 

• From your Certificate you should also be able to find the 

Arm value of the fuel tanks

• More than one Fuel item can be entered

• The total fuel is used for the Fuel Calculation

• EXCEPT…

• An Item with a name starting with “Fuel-Aux-s” 

(Separate Aux Fuel) is interpreted as fuel carried in or on 

the aircraft but not available unless there is a fuel stop 

(see Flight Log)

• This quantity is not used in the Fuel Calculations except 

where there is an en-route fuel stop.

• Enter the Pilot with Weight and Arm

• Enter the Luggage weight and its Arm value

• You can add further stations by right-clicking and Insert. 

• You may also change the name of the Stations except 

FUEL stations.

This will now give you your total weight as loaded for that 

flight. You should print out this page.



Planning your Flight in Map View

Almost an entire route can be entered from the Map view by RIGHT clicking on your departure airport, then 

your destination airport. If your destination is far, search and add it within the FlightLog window.

To add boundary points first LEFT click on the track line, then RIGHT click for the options to add. 

Here are some tips on how to do this:

Display

• Use the top buttons on the toolbar to switch on or off display of airfields, restricted areas, reporting 

points, navigation aids etc.

• Ground features can also be turned off for easier viewing. Click 

• Go to ‘Units & Preferences’ to switch on or off the ground features, as required.

Zooming with buttons

• Use the Auto Scale button to view the route. 

• Use the  +  and   -  buttons to zoom in and out. 

• Use the Display South Africa button to display the whole map.

Zooming with mouse

• Right click on a free part of the map and select the PopUp menu item to Zoom in and out.

Best way : Press and hold the Ctrl button on the keyboard. Press and hold the Left Mouse Button and move over 
the area that you want to view, then release, or use Mouse Wheel



Planning your Flight in Map View

Panning

• Press and hold the Left Mouse Button down and then move. The map will follow the mouse.

Measuring Distance

• Press and hold the Shift button and then press and hold the Left Mouse Button. 

• Move the mouse and the distance and magnetic bearing will be displayed at the bottom of the screen.

Displaying Information

• An aeronautical item on the map will be highlighted in lime green as the mouse moves over it.

• Right Click and go to View to display additional info on the item. 



Planning your Flight in Map View

Adding a Point - to the end of a route

• Make sure no leg is selected. De-select 
a selected leg by Left Clicking on the 
highlighted leg.

• Switch on the points of interest. 
(Airfield, NDB etc). 

• Right Click on the highlighted point and 
go to the Add menu item.

Inserting a Point - in an existing leg

• Left Click on the leg to select it. The Leg 
changes colour to GREEN

• Right click on the highlighted point and 
go the Insert menu item.

Inserting a Flight Boundary - in an 
existing leg

• Left Click on the leg to select it.
• Make sure the boundaryies are 

selected. (FIR, TMA etc.)
• Right click on the highlighted boundary 

and go the Insert menu item, or
• Select from the menu ”Flight 

Boundary”

It might be easier to work on and plan your Route if Ground Features are 
turned off. Turn ON again if you view your Vertical Navigation.



Planning your Flight in Map View

Inserting a Waypoint - in an existing leg

• Left Click on the leg to select it.
• Make sure no point is highlighted, Right click on the map and go the Insert Waypoint menu item (a Waypoint 

can be inserted on the leg or at the mouse position).

Radial from ... (any VOR)

• Left Click on the leg to select it.

• Move the mouse over the VOR Right Click. Select the menu item “Radial from xxx”. The "insert waypoint" 
menu is displayed. 

Inserting a Waypoint abeam of an existing point - in an existing leg

• Left Click on the leg to select it.
• Move the mouse over the point abeam the selected leg and Right Click. Select the menu item Insert Waypoint 

Abeam xxxx. If the menu is not available then the point is not abeam the leg.

Deleting a Point or Waypoint

• Left Click on leg to select. (Note - the highlighted point is the selected one).
• Ensure that no additional point is highlighted (maybe switch off some of the displayed points)
• Right Click on the Map and go to the Delete menu item.
Viewing Details

• Select the leg by Clicking with the Left Mouse button. Ensure that no additional point is highlighted. (maybe 
switch off some of the displayed points)

•  Right Click on the Map and go to the Display Leg Details menu item.
Map Notes

• Right click on a boundary and select Details to Notes to send the details to the route notes. 



Planning your Flight in Map View

In MapView you can create a waypoint anywhere on the 
map. You can edit your Waypoints, e.g. if you want to have 
your point on Track, or At Co-ordinates.

You can also check your Legs and edit Altitude, Windspeed, 
Direction, Air Speed, Fuel Consumption, or if that Waypoint 
needs to be in Flight Plan or in EET of Flight Plan.

You can view the LEG 
Details by click right 
clicking and 
highlighting that Leg.

Edit Waypoint
• Change the Waypoint and press OK when 

complete.
• Check Include in Flight Plan if the point must 

be part of the Route information in the 
Flight Plan.

• Check ‘Include in EET’ if the point must be 
included as part of the EET information in 
the Flight Plan.

• When in MAP mode the Waypoint can be 
moved to the Co-ordinates of the Mouse by 
selecting At Co-ordinates and Clicking on 
“Mouse Co-ords”. 

Remember when inserting or 
editing Waypoints to select for 
them to be in the Flight plan 
or to be included in EET in the 
flight plan. Estimated Elapsed Time



Planning your Flight in Map View

Zoom In

• Press and hold the Ctrl button on the keyboard. Press and hold the Left Mouse Button and move over 
the area that you want to view, then release.

      
Zoom Out

• Press the Right mouse button.

Climb and Descent 

• Press the "Climb and Descent" button or go to the Top menu item "Route/Aircraft" to insert or remove 
climb and descent waypoints.

• Climb and Descent rates are as specified in the Aircraft Performance.

• Wind is taken into account.

Note: It is better to remove Climb and Descent points when editing a route.

An alternate destination airfield is not displayed in the vertical navigation.

VFR:

A leg with a height designated as VFR will be shown as a line joining the point 1500ft above the first point 
and 1500ft above the second point of the VFR leg.

TOC = Top of Climb.
DES = Start of the descent



Vertical Navigation

• The Blue Line represents the aircraft. 
• If Climb and Descent points have been inserted, then the blue line will be sloped, 
 otherwise it will be square.
• The Brown Line is the ground elevation directly along the flight path.
• The Gray Line is the highest ground elevation within five nautical miles of the flight path This can be 

changed in the Map Preferences.

The Vertical Navigation 
view can be printed with 
the Map. 

Printing in Portrait mode 
places the Vertical 
Navigation underneath the 
Map on the same page. 

Printing in Landscape mode 
places the Vertical 
Navigation and the Map on 
two separate pages.



Flight Log



FlightLog

The Flight Log shows the route in table format. 
You can also plan your flight in this format by simply adding the points of departure and destination. 
Then check in MAP VIEW if any other points need to be added, like Airspace Intersections.
In the FLIGHT LOG you can adjust your altitudes or Flight Levels.
Frequency Column - the frequencies are automatically calculated according to which Airspace you are entering 
and at what ALT/FL

Editing
• Mouse click in the 1st column to add, insert, delete a point or way point.
• Mouse click on the light blue text to change the value.
• Mouse click on the Units to change them.
• Mouse click on the Heading in the top row to switch the column off, display ALL or return to DEFAULT

Alternate Destination is marked in RED. Go to Route/Aircraft. Set  Alternate Destination on/off 

NOTES
These notes are saved, together with all the flight details, and can be printed with the Flight Log. Use for 
current Notams or special instructions.
 
You can also add notes directly by right clicking on a border while in the map view.



FlightLog

NOTES

Find All Air Spaces
Finds all the air spaces the route goes through 
and lists them together with their frequency.
Searching can take a few minutes, depending on 
the length of the route, and speed of computer.

Find All NDBs and VORs
Finds all navigation beacons within 20 nm of the 
route and lists them together with their 
frequency

Note on formatting:   “.b” prints the line 
in bold.
    “.h” hides the line. 
(Not printed).



Flight Plan
From the Flight Log, an ATC Flight Plan is 
created.
There is an automatic flight plan check 
with warnings if the flight plan needs to 
revised: e.g.



Flight Plan 

Updating and Checking

• The Flight Plan updates automatically if the 'Automatically Up-date FP' in the Units & Preferences check 
box is ticked. Otherwise press the Button "Update & Check" Flight Plan

• Data for the Flight Plan is extracted from the Aircraft details, the Flight Log and the Weight & Balance.
• Note that the Fuel quantity comes from the Weight & Balance.

The following fields in the Flight Plan will be updated automatically : 

F i e l d  18
Line 1: Used for EET. Automatically updated.
Line 2: Used for departure, destination and alternate info. Automatically updated.
Line 3: Used for OPR/ DAT/ COM/ and NAV/ fields. 
  “NAV/GPS” inserted automatically if a “Z” selected in equipment 
      and no other NAV/ field is already entered.
Line 4: Used for SAR and any additional remarks. 
  Note that the SAR must be last in the list. If touch and go is required 
      add “RMK/REQ T AND G FAGC FALA FAWB RMK/SAR NML”
More info on SAR:   The correct way to file the SAR is as follows: 
 - RMK/SAR NML, not SAR/NML as “SAR” is not a recognized field identifier.
 - SAR must be filed according to all the CAA accepted formats namely:
 - RMK/SAR NML
 - RMK/SAR NML ENROUTE
 - RMK/SAR FAJSETA 1HR
 - RMK/SAR NIL
 - RMK/SAR FAJS1600

1. Departure Aerodrome
2. Departure Time
3.  Cruising Speed
4.  Level  
5. Route
6.  Destination Aerodrome
7.  Total EET
8.    Other Information: EET for FIR crossings
9.    Endurance

in EET
The software automatically calculates the 
estimated enroute time to FIR boundaries. 
EET/ Significant points or FIR boundary 
designators and accumulated estimated 
elapsed times from take-off to such points or 
FIR boundaries, when so prescribed on the 
basis of regional air navigation agreements, 
or by the appropriate ATS authority 



Flight Plan and Filing with File2Fly 

File2fly is a pilot self-briefing service 
provided by ATNS, where you can file 
flight plans ... Register and log in to 
have access the latest NOTAM and 
aeronautical information.

• Open File2Fly
• Then copy and paste the ICAO 

FlightPlan text from EasyPlan



Flight Plan and Filing with File2Fly 

• Open File2Fly
• Go to : FlightPlan Import
• Then copy and paste the ICAO 

FlightPlan text from EasyPlan
• The information will be verified, 

and you should get approval 
within a short period.



Points

User Points
Can be added, edited or deleted. 
However, a User Point cannot have the 
same name as an existing point in the 
main EasyPlan database.)
• Type of point: Points are divided into 

8 different categories. In Map View 
each type of point can be turned on 
or off.  

• A category Other can be used for 
your special destinations or your own 
User Points. But don’t forget to 
provide AviationDirect with details, 
should you want your airfield added 
to the main database.

Depending on the Settings of your format for 
Latitude/Longitude, enter the details and make 
sure all the spaces are fill, with zeroes at the end.
• Latitude: Enter five or six digits for the 

latitude, starting with S
• Longitude: Enter five or six digits for the 

longitude, starting with E
• Frequency: Enter a frequency if required. This 

is saved as a text string.
• Info File: Enter the name of a text file that 

contains additional information on the airfield. 
The Open button is enabled if a valid file 
exists. If no file exists, a file can be created or 
linked by entering the edit mode.

• Picture File: Enter the name of a .JPEG file that 
contains a picture of the airfield. The open 
button is enabled if a valid file exists

• Elevation: Enter the elevation of the airfield.

Select the point required by entering the 
first few letters in the top edit box, and 
then select the point from the displayed 
list.
The following data is kept for each point:
• Name: e.g. Grand Central, 
• Identification: ICAO code of airfield or 

VOR or Reporting Point: e.g. FAGC, or 
HGV or NEXIS

• Only User Points can be deleted.

Or Viewing Point or New Point

Point Manager
EasyPlan Points: An extensive database exists 
of airfields and navigational aids in Southern 
Africa. This database is fixed and cannot be 
edited. Updates can be downloaded from the 
website www.aviationdirect.co.za  - Latest 
Updates - EasyPlan



GPS Interface
All Garmin GPS should be supported, 
although not all have been tested.
Connecting a GPS
• Plug GPS into computer serial port 

Switch on GPS.
• Select the port number 
• Click on Open GPS Port.
• “GPS Detected” should be displayed if 

communication with the GPS has been 
established. If not, check connections 
and port number.

USB
• EasyPlan communicates with the 

Garmin GPSs using USB. It works as 
the serial connection described above, 
except “USB” must be selected 
instead of “ComX”. 

• The Garmin drivers must be previously 
installed.

Some common problems
• Wrong communications port selected. Most computers use Com1 or Com2
• The Communications port is being used by another application.
• Often cellphone communications software holds the port even though the cell phone is not 

connected. When EasyPlan reports “Error opening com port” then it is either not available on 
the computer, or in use by another application. 

• The Garmin protocol is not selected on the GPS. EasyPlan reports “Port Open” and “Msg Sent 0” 
but gets no response. This indicates the GPS is not connected to the port, or is set on the wrong 
protocol. See the GPS Operating Instructions. 

NOTE:
The easiest way is to Export 
your Flight Plan to a .gpx Format 
which is a universal format 
accepted by most GPS. You can 
copy that file from the folder to 
the GPS or to a SD card for your 
glass cockpit GPS.



GPS Interface 

Route Transfer
• Select a special GPS Character to be 

appended to a waypoint name when the 
waypoint is not in the Point Database.

• The Special GPS Character is appended 
onto any waypoint to differentiate 
between waypoints of the same name in 
different routes. 

• Waypoints modified are all that contain 
the letters: FIR, CTR, ATZ, TMA, FAR, 
FAD, FAP, CTA, UTA, WPT, XPT, ABM, 
TOC and DES.

• If you are downloading more than one 
route to the GPS, ensure you choose a 
different letter for each route, or ensure 
all names in the routes are unique.

• Click on Check GPS Data. This converts 
the waypoint names into a format 
suitable for the GPS and checks for 
duplicate names that do not refer to the 
same point. Note that waypoint names 
are modified to be meaningful using a 
length of six characters - the maximum 
available in most GPS.

• Change the route name if necessary. A 
route with the same name already in the 
GPS will be overwritten.

• Waypoint names can also be changed, 
but do so with care.

• Click on Download Route to send the 
current route to the GPS.

Tracks and Tracks Transfer
• Click on Get Tracks to read all the stored tracks from the GPS
• Tracks can be saved to disk.
If you use EasyCockpit you can save your Tracks to your computer 
(folder in MyDocuments – EasyPlan3)
• READ Tracks to Select the tracks to view on the map. 
• APPEND if you have more tracks or different legs
• You can Change the Name of the Tracks for easier reference



GPS Interface - Export Tracks to Google Earth

TRANSFER TO GARMIN AERA 500
• Connect the Garmin Aera to your PC. It then appears as a Memory Device on your PC (My Computer). 
• Open the route on EasyPlan. Go to “EXPORT” and select “Create .gpx file” A folder called “GPX Files” is 

automatically created under My Documents - EasyPlan and the .gpx route is saved into that folder. 
• Copy this file into the /GPX/AVIATION folder on the Garmin device.
• In the Garmin device: go to: “Active FPL - Menu - FLightplan List “ - choose Route - ACTIVATE FP - then 

select “Home” - Map to display



TOP MENU ITEMS  :  FILE

New      -    To start a new route.

Open     -   Opens an existing route.

Reopen     -   
 Re-opens a route that you previously saved.

Save  -   Saves the current route.

Exit          -   Closes EasyPlan.

Save As  -    Saves the current route with a new name.

Print -    Gives you the option of printing the Flight Log, Flight 
Plan, Map or Weight & Balance, or if you like to print the Log 
Book, the  Summary or the Renewal Form. 

 Using the Print icon prints whatever page you have open 
at the time!
Tip:   Use the PRINT icon to print the current item being 
viewed.

Copy Image to Clipboard     -  Copies the current view 

to the clipboard so that the image can be pasted into 

another program

Copy Text to Spread Sheet    -  Copies the Flight Log to 

the clipboard so that the data can be pasted into a              

Clipboard or Word Processing program.

-  Data is in Tab delimited form.



Route /Aircraft
Invert Route  
The current route is inverted. If the heights are the 
same as the aircraft defaults for that direction, the 
inverted route will have the correct heights for the 
new opposite direction. 
If the “Alternate” function is on, a new Alternate 
destination must be selected.

Insert Climb and Descent Waypoints
Calculates the Top of Climb (TOC) and the Start of 
Descent (DES) points using the aircraft details and 
the flight levels set in the Flight Log. It is best to 
enter the complete route, and then calculate the 
climb and descent waypoints.

Remove Climb and Descent 
Waypoints
Removes the climb & descent 
waypoints automatically 
inserted by using the previous 
function.

Set Alternate Destination On/Off
If “Alternate” is on, the alternate destination is 
always the last point of the route and is displayed in 
a different colour in the Flight Log and the Map. 
When “Alternate” is on, fuel calculations will be 
done to the destination and alternate destination. 
Switching the “Alternate” function off does not 
delete a point, but changes the final destination to 
what was previously the Alternate destination. The 
vertical display only includes up to the final 
destination.

Set Fuel and Speeds to 
Default Values
All the fuel 
consumption figures 
and the airspeeds in the 
Flight Log will be set to 
the defaults as in the 
Aircraft section.

Import Route Data
Extracts only the route part of the data from a previously saved 
route.

Import Aircraft Data
Extracts only the aircraft data from a previously saved route. Use this if 
you have created a route and you want to fly the identical route in a 
different aircraft.



POINTS

LOGBOOK
Save - Saves the current Logbook

Save As - Saves current Logbook but not Systems

BackUp  - Periodically back up the Logbook onto 

a disc /cloud/ flash drive. Backup the current 

LogBook and Systems

Restore  - Restore Logbook from disc/ cloud/ 

flash drive (.da1 or .dat2)

Export - Export Logbook onto a disc / cloud / 

flash drive in txt format

Import - Import Logbook from a disc / cloud / 

flash drive in txt format

Get Import Headers – Creates headers to be 

used in Excel spreadsheet

New - Opens the Point Manager page ready to insert a new point in the user 

database.

View - Opens the Point Manager page showing a list of all points in the database.

Add - Appends a point to the end of the route.



EXPORT

Your Flight Plan / Route can be exported to various GPS:
• Map Create – for Lowrance Airmap GPS (see next page)
• MGL Flight Plan only is exported and can be saved onto 

an SD card to be read in the MGL – the file format is .ert
• With MGL you can also export Data.
• This feature requires an activation and subscription where 

the full     aeronautical database can be exported to your 
MGL. The MGL serial number is required for this. The file 
format is .ewd

• Selecting Export Route let’s you create a
•  .gpx file which is fairly universal for most GPS, including 

the MGL
• .fpl file is recognised by the Garmin GPS
• And the .kml file for export to Google Earth

EASY COCKPIT

If you also have the EasyCockpit App, this exports 

the  Routes/Flight Plans for your mobile devices 

(phone/tablet). 

It creates the route in .efp format and saves it to 

Documents/EasyPlan3. 

It also opens an email with the files attached, to be 

emailed to yourself to your mobile devices



How to Update your EasyPlan

AviationDirect provide regular updates to EasyPlan, generally airspace, 
airfields and navigation data updates as well as product improvements. 
To be able to download updates, your subscription has to be valid.
The software shows that information when EasyPlan is opened: 
“Update Days Left: 345”

You can check which version of EasyPlan you have installed by going to:  
‘Help’ > ‘About’ in EasyPlan.
The following window will appear displaying various information 
relating to your EasyPlan:

To update your EasyPlan, please follow the instructions below:
1.  Check you have a valid EasyPlan subscription to updates (you can 
check this by going ‘Help’ > ‘About’ in your EasyPlan – see ‘Update Days 
Left’)
• If your subscription is valid, continue from point 2.
• If your subscription is not valid, see ‘Renewing Your Subscription to 

Updates’ further down this page 
2.  Download the latest EasyPlan Version 3.151 now - Go to 
www.aviationdirect.co.za > Updates > EasyPlan Update



See Latest Version (outlined in orange)

Enter your Easy Plan Program ID (10 DIGITS BEGINNING WITH 2 OR 3 WITH A DASH INBETWEEN THE FIRST 5 DIGITS AND THE LAST 5 DIGITS. 

Please call if you do not know your extended Program ID) in the space provided (red circle) and click ‘Show Updates’ to reveal the updates 

available for you to download.
 

You have 2 options from here: ‘Run’ or ‘Save’

a. ‘Run’ the update if your EasyPlan is loaded on the computer you are currently downloading/working on. You should be confident 

you will not need to install this update again at any stage

b.  ‘Save’ if you might have to install the update again (perhaps incase installation is cancelled before complete) or if your EasyPlan is 

loaded on a PC that does not have direct internet access. Make sure you remember where you saved it to.

Select Update 

How to download an Update



Installing Updates – Troubleshooting

Depending on your Windows version there are other warnings that could come up

Put your cursor on the 3 dots 
for More Actions, select KEEP

Select SHOW MORE, then 
KEEP ANYWAY



Fighting the antivirus and Windows

Downloading and installing an EasyPlan update

When Windows gives this message – Click on 

More Info

Then click on the “Run Anyway” option that 

comes up

Click YES, to allow this App 

to make changes to your 

computer.

Then INSTALL … finally



Renewing Your Subscription to Updates

You can check if your subscription to updates has expired by going 
‘Help’ > ‘About’ in your EasyPlan program. 
This opens a window which displays your current registration 
information. 
Look at ‘Update Days Left’ to check how many days you have remaining 
on your current subscription. 
EasyPlan subscription to updates work on an annual fee that allows 
Users to download updates as and when available from the website 
throughout their year of subscription. 
All users who purchase the software receive their first-year subscription 
to updates free. 
This is calculated from the date of product registration.

If your subscription to updates has expired, please contact Aviation 
Direct



Updates

Content of Updates

EasyPlan Updates mainly contain updated airfield data, aeronautical information and communication 
frequencies. Updates can also contain software upgrades and improvements.

How Frequent are Updates?

Major updates containing airfield and aeronautical information are available on average every 2 months. 
‘Sub’ updates are available when necessary, between the major updates.

How will I know when a new Update is Available?

Aviation.Direct notify all their registered users of updates that are available for download. 
This is done via the email address used to initially register the software.

Keep a check on our website for any ‘Sub’ updates as we do not necessarily notify by email for these.

www.aviationdirect.co.za > Updates > EasyPlan 



TIPS & Troubleshooting

Entering your Aircraft Data
Tip: open an existing aircraft type which is similar to yours (Route/Aircraft > Import Aircraft Data), then change 
numbers according to your aircraft's operating manual. 
"Save As"  your aircraft registration and type.

Hi-Res data not displaying

- The files should be in c:\Program Files\EasyPlan\EasyPlan3\Dem
- They must be unzipped and have a “.hgt” extension
- Files must have the “Read Only” flag cleared.

- You must be using EasyPlan version 3.030 or later

- Enable “Hi Definition Elevation” in “Units & Preferences” “Map”

- Move the slider on the map page to about the middle

- The file name refers to the bottom left corner of the block

Note: The full EasyPlan program is NOT available for download because of the size of the topographical 

data. 

If you install EasyPlan from a download, it will NOT display the topographical data.



Q&A

I have discrepancies between the flight log and flight plan. Some way points are missing from the flight plan and
changes in flight levels/altitudes are also missing.
On the flight plan click on the top button “Update and check Flight Plan” to do just that. 
Also go to “Units and Preferences” “Flight Log” and switch on “In Flight Plan” to see which points will be in the flight plan. 
User points that are part of a straight course without an altitude change do not need to be in the flight plan

I have downloaded the latest update of Easy Plan from your web site and am getting an ERROR message that reads “Floating 
Point Operation” when the program is started. Would appreciate if you could advise on a fix for this problem.
If EasyPlan starts, go to “Units and Preferences” “General” and press “Set Defaults” and then restart and see if this helps. 
Also check the default height under aircraft data is not 0. Be careful when you add any User Points, wrong co-ordinates also 
cause this error. 

Printing Issues:

I can’t print the map with the flight plan on my printer.
Not being able to print the map is due to the program not recognizing a certain printer. You can either print to file, and then 
print the .bmp or .jpg image, or you can print to Adobe .pdf

I don’t have a printer connected to my laptop, is there any way I can email flightlogs or maps?
No, this is unfortunately not possible, but a good option is to print to a .pdf file and then email or print from there. Free 
programs are available from the following sites: 
http://www.pdfforge.org or http://sourceforge.net/projects/pdfcreator/

I get this message after downloading the update: “Files Corrupt” please contact Aviation Direct
You will receive this message if your internet connection has been interupted during the download. This means that the full 
update is not available - you might see it in the size of the file (an update at the moment is more than 7MB). 
You need to download the update again. BUT before doing so, you will have to delete the temp file that has been created 
(corrupted update), as it will run the corrupt file. 
To do this, open Internet explorer, click on TOOLS and on INTERNET OPTIONS. Once there, click on “DELETE TEMP INTERNET 
FILES” to delete the corrupted file. If you are running Mozilla Firefox, open page - Select ‘TOOLS’. then select ‘CLEAR RECENT 
HISTORY’. If you cannot access the page, here’s another option: close internet explorer, Click on START, go to CONTROL 
PANEL and double click on INTERNET OPTIONS. Under the tab ‘GENERAL’, under the Temporary Internet files click on Delete 
files. In the Delete files box, click to select the ‘Delete all offline content’ check box, then click on ok.



GPS

Can’t connect Garmin GPS to computer
 
The other method is by using EasyGPS. If you have a route loaded and click on “Export gpx” it should open EasyGPS 
with that route loaded. Does that happen? Then click on “Send” to send it to the GPS. Does that work?

“Fix Gps Data” converts the longer names into ones suitable for the GPS.
Are you sure the GPS is on port 3? EasyPlan is not getting any response from the GPS. Is the “Garmin Protocol” 
selected on the GPS? 
 
The “Fix GPS 96” only changes the timing if you are connected to the GPS on a USB port. 
 
All the items in the “Track Transfer” area are for reading tracks from a GPS or a file and “Export to Google Earth” will 
export the track and display it in Google Earth. (we do need to update our help file to describe these items in more 
detail)
 
Try installing EasyGps. This is an alternative way to download file. When you click on “Export gpx” then a file is created 
in the folder “...... Documents\EasyPlan3\GpxFiles” and EasyGps is run. (It automatically loads the file) 
Then try sending the file to the GPS via EasyGps. 

Running Easyplan on a Mac:

Easyplan does not run on an Apple Mac.

If you do want to use Easyplan on a Mac, you will need a Windows Emulating software to run windows on an Apple 
computer. For example: Crossover, Parallels, Fusion, Apple Boot Camp

For more information on these programs/options please go to: http://www.fileinfo.com/help/windows_on_mac

http://www.fileinfo.com/help/windows_on_mac


Other Issues, please see example below:

Hi there,
Mayday, mayday, mayday!!!
I have been using Easy log for about 3-4 years and have never had a problem.
I tried to open the software program today and was given and error : “list index out of bounds (0)”.  All my data is gone!!
What now?  Please help!

Answer: Sounds like a file is corrupt. Try this:

1. Close EasyPlan if running. 

2. Rename the “EasyPlan3” folder in “My Documents” folder to “EasyPlan3x” 

3. Run EasyPlan. If the error still occurs then try running the update install again. 

4. If you then get no error then close EasyPlan. 

5. Start copying some of your files from the “EasyPlan3x” folder to the “EasyPlan3” folder and run EasyPlan after copying. If you get 

the error then the problem is the file you have just copied. Please send it to me.

(just close EasyPlan when you copy the files and run after copying) 

6. The files of importance are:

LogBook.dat2 – your logbook file. 

*.ep1 – all your saved flights – I am sure these are not the source of the error

*.dat – some initialization data. Could be a problem

*.ini – initialization data. Could be the source of the problem

I would like to know what the real problem is and would be grateful if you could send me the file that is causing the error or zip the files 

in the “EasyPlan3x” folder and send them to me.
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